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About this tutorial
Congratulations on your selection of XMPie uCreate Print for your Variable Data Print (VDP) needs. 

The XMPie EDU Tutorial is a series of tutorials that together will provide a thorough introduction to VDP 
techniques using Adobe InDesign and XMPie uCreate Print.

The EDU Tutorial is divided into different sections to enable you to quickly jump forward or backward to 
find help to learn different aspects of the product functionality:

	z Part 1 - Project planning, preparation and gathering
	| Understanding the project 
	| Checking the available data
	| Checking the available image and text file assets
	| Planning what content objects are needed to achieve the desired outcome

	z Part 2 - Basic VDP job
	| Linking to your data source
	| Placing Text and Graphic Content objects into the InDesign document
	| Managing text copy fitting and dynamic graphic fitting
	| Creating your first VDP output

	z Part 3 - Using rules and logic
	| Introduction to the Rule editor
	| Functions and how to use them
	| Creating rule or logic

	z Part 4 - Introducing more content object types
	| Creating and using Visibility, Style and Text File content objects

	z Part 5 - Barcodes
	| Creating and using print barcodes

	z Part 6 - uImage regular font effects
	| Creating a font-based uImage template with Adobe Photoshop
	| Creating a uImage Document Package
	| Optimization techniques

	z Part 7 - uImage image font effects
	| Creating an image-font-based uImage template with Adobe Photoshop 
	| Creating a uImage Document Package
	| Optimization techniques

	z Part 8 - Using the uImage package in uCreate Print
	| Linking InDesign and uCreate Print to the uImage package

	z Part 9 - Table Content objects and uChart
	| Linking to secondary data sources
	| Table Content objects
	| Adding uChart to the document

	z Part 10 - Working with uProduce
	| Creating Campaign- and Document-packages
	| Uploading packages to the uProduce Dashboard
	| Processing the document on the server
	| Working with Circle
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Target audience
This tutorial is designed to provide basic information, step-by-step instructions, and sample materials for 
self-learning. Should you require more visual assistance, there are accompanying videos available at  
http://campus.xmpie.com/s/uCreatePrint. 

At the end of this Tutorial, there are review questions, and suggested exercises to build on the skills 
outlined in the tutorial.

The content is designed for customers who have bought XMPie uDirect or PersonalEffect and wish to 
learn how to use XMPie's uImage product to create personalized image templates for use together with 
uCreate Print and VDP production.

It is expected that the reader will already have a basic working knowledge of Adobe Photoshop. If not, it 
is recommended to first complete some basic Photoshop training  for example, courses with Adobe: 
https://helpx.adobe.com/indesign/tutorials.html or a 3rd party organization such as Lynda.com: 
https://www.lynda.com/InDesign-training-tutorials/233-0.html

Document structure
This tutorial uses the following icons to draw your attention to special key items to help you identify the 
information you are looking for when completing the tutorial.

Sections of the tutorial which require hands on action will be highlighted with the following icon.

Step by step instructions

This is an example of step by step instructions.

Reference materials
	z uImage User Guide (Access via the help menu on the Dynamic Content menu).
	z uCreate Print User Guide (Access via the help menu on the Dynamic Content menu).
	z uCreate Print Tutorial videos (Access at http://campus.xmpie.com/s/uCreatePrint)

Prerequisites
This tutorial assumes that you:

	z Are familiar with Photoshop CC, 
	z have Adobe Photoshop CC2022 or later installed (trial version is acceptable),
	z have XMPie uCreate Print installed. (uImage is installed as part of uCreate Print), and
	z uImage license must be installed. (It is not possible to use uImage Trial for image font effects.) 

Additional information and notes

This is an example of additional information and notes.

NOTE: Special attention and warning

This is an example of special attention and warning.

http://campus.xmpie.com/s/uCreatePrint
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Module 1: 
Introduction and overview
In this module, we download and unzip the tutorial resource files. We will investigate the provided files, 
and get ready to start work in Photoshop.  This overview will also describe what we want to achieve in 
this sample tutorial.

Duration
About 5 minutes

Objectives
After completing this module, you will be able to:

	z Download and unzip the provided sample Photoshop file, 
	z Download and install the sample font, 
	z Check the required image size and resample if needed, and
	z Understand the expected outcome of the tutorial.

Procedure
Unzip and review the contents

Step by step instructions

Unzip the resources package. You should see the following files:
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In addition to this PDF tutorial, the files include a main Photoshop template and a folder of 
image letter assets.

Confirm the image size needed for the InDesign document

To ensure the best image production performance, it is recommended to create your uImage templates 
at the right size and resolution.

Step by step instructions

In the previous tutorials 
of this series, we have 
been working with the 
EDU Postcard Template 
InDesign file.

Open the document 
and use the Selection 
tool to identify the 
width and height of 
the image we want to 
replace with uImage.

Open the sample Photoshop file

Step by step instructions

Open the graduation-image-font.psd Photoshop file.

Click and hold the document size information 
to view full details of the image size and 
resolution.

Additional information and notes

In order to create an image font effect with uImage, you need to create images 
for each letter character that you expect to need. For example, the provided 
assets for this tutorial include the letters a to z and the hyphen (minus sign) and 
apostrophe characters.

Additional information and notes

Non "a to z" characters need to be named by the Unicode value of the character. 
For example, the apostrophe character is 0027 in Unicode.
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Customer requirements / tutorial objectives

Our customer - EDU University - want the mail piece to cut through the mailbox clutter. Students will 
receive a lot of material from different universities at around the same time, so they want their postcard 
to have some visual interest and hopefully be remembered/recalled by students.

In order to do this, we are suggesting to include a personalized Image effect created with uImage

The effect we will create is to add 
the student's firstname into the 
image as if it was formed by the 
mortarboards thrown in the air.

Tutorial tasks
	z Placing and positioning the smart objects in Photoshop (page 9).
	z Renaming the smart object layers (page 10).
	z Exporting the XMPie Document package (page 12).

Additional information and notes

For this example, the image size is almost the same and there is no need to 
resample the Photoshop file, but you should bare this in mind for your future 
uImage templates.
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Module 2: 
Placing the smart objects in 
Photoshop
Duration
About 10 minutes.

Objectives
After completing this module, you will be able to:

	z Place images into Photoshop to create smart objects,
	z Experiment with Photoshop positioning and filters that can be placed onto smart objects to create a 

more realistic effect, and
	z Name the smart object layers in a way that uImage can replace the image contained in the layer.

Procedure
Adding the smart objects to the Photoshop file

Step by step instructions

From the File menu, select 
Place Embedded...

Browse to the assets folder 
and select one of the letter 
images. (It does not matter 
which letter image you 
choose.)

Change the size, rotation and 
position of the first letter.
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Repeat the steps to place 
and position additional letter 
images into the image. You 
should be able to place 8 
letters into the image.

Tagging the layers for uImage

Step by step instructions

Open the Layers panel from 
the Window menu.

Double-click on the text part 
of the layer name.

Rename the first layer <L1>

Repeat for the second layer 
naming it <L2>

Repeat for each layer 
increasing the sequence 
number.

When completed all layers 
should be tagged and 
numbered.

NOTE: Special attention and warning

Do not copy and paste or duplicate an existing letter. You must place each letter 
into the image separately using the File > Place Embedded menu.

Additional information and notes

The layer name needs to start and end with the <> characters to be seen as a tag 
by uImage.  Each layer needs to be numbered sequentially from the first letter to 
the last. The layer name can include a text prefix. I generally use L to represent 
"letter".
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Save your document

Step by step instructions

Save your Photoshop file. If you wish to repeat the tutorial in future, you may want to use 
Save As... so you can return to the original sample file.



12	 XMPie EDU Tutorial Part 7 - Image font uImage effects	 XMPie Training

Module 3: 
Exporting a Document Package
Duration
About 5 minutes.

Objectives
After completing this module, you will be able to:

	z Export an XMPie Document Package (DPKG) for an "Image font" based uImage effect.

Procedure
Exporting the XMPie DPKG 

Step by step instructions

From the Photoshop File 
menu, select Automate, and 
then select Export XMPie 
DPKG...

Browse to choose a location to save your Document Package and enter a suitable name for 
the package. By default the package name will be the Photoshop file name.

Set the Template Type to 
Image Font.

Set the Personalization Text 
to First and Last name.
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Additional information and notes

The Personalization Text field is allowing you to choose between pushing one 
database field or two fields into the image.  
Custom = 1 database field.  
Firstname and lastname = 2 database fields. 
Using the first and last name option automatically looks for asset images for 
each letter in the recipient name processed by uCreate Print or uPlan. While 
using the Custom option will look for an asset image with the name that you 
chose with uCreate Print or uPlan logic. The example below shows different 
holiday images added as smart objects to the background image with uImage.

Additional information and notes

When you select the Firstname and Lastname option, uImage will evaluate the 
number of letters in the two database fields and the number of smart object 
layers in the Photoshop file and select to use:

1) If firstname and lastname will both fit in the image: 

2) If only firstname will fit in the image: 

3) If firstname will not fit, uImage will use the first and last initials: 
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Select how to align the text. 
For this example, I will choose 
left.

Enter the Tag Prefix if you 
used one when naming the 
layers. 

Enter the number of images or Tag layers you created.

Click Browse and select the 
folder containing the asset 
images.

Actions, scripts and 
optimization are not required 
for this example. Please refer 
to the uImage User Guide for 
more information on these 
settings.

After setting the Tag prefix 
and Number of tags, you 
should see the tags listed in 
the Additional Information 
Area.

Click Export to create your XMPie Document Package.

Where to now?

Now that you have created your Document package, it can be used to create personalized images with 
uCreate Print or the XMPie uProduce server.

To learn how to use the package with uCreate Print, continue on to Tutorial 8.

Additional information and notes

If you do not see uImage Tags listed in the Additional Information area, you have 
not named the layers correctly with the <> characters, or you have not set the 
correct Tag prefix or Number of Tags values.
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Review and extra exercises
To consolidate your understanding of the topics covered in this tutorial, please answer the following 
review questions, and complete the additional exercises:

Review questions
What is the main reason for using personalized images in a marketing campaign? (Page 8)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

What will happen if the name in the database will not fit within the number of smart objects in the 
Photoshop template? (Page 13)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                               

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

How do you name asset images for European accented characters? (Page 7)   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                  

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Where do you find the Export XMPie DPKG menu? (Page 12)

  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .

Additional exercises
Exercise 1

Think of an image concept where letters could not be created with a font. For example, pebbles on beach, 
autumn leaves on grass, M&Ms or Jelly Bean candy spilt on a table...

Find a background image (beach, grass, table) and create your overlay letter images (snap some photos 
or create the images manually in Photoshop) for all A-Z letters and repeat the tutorial using your images.
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